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License and copyright

This document is licensed under the Creative Commons Attribution-NonCommercial-ShareAlike
4.0 International License (CC BY-NC-SA 4.0). This means that you are free to copy and redistribute
the material in any medium or format, and remix, transform, and build upon the material, as long as
you give appropriate credit to the original author, use the material for non-commercial purposes
only, and distribute your modifications under the same license as the original.

MyRaillO®is a trademark of Jonas Bjurel. All rights reserved. The MyRaillO logo is a copy right
design of Jonas Bjurel and may not be used outside of the MyRaillO project without permission.

Resources

All MyRaillO resources can be found at https://www.myrail.io/

The MyRaillO source code can be found at https://github.com/jonasbjurel/myRaillO

Introduction

MyRaillO (mai1reilio) provides an Input/Output peripheral backend to model railway
controllers such as JMRI, RockRail, etc. (at current only JMRI is supported).

MyRaillO provides flexible and configurable capabilities for the model railway controller to

throughout the layout capture diverse types of sensors-, control multiple types of sighaling
masts-, control diverse types of light-effects-, and maneuver actuators such as turnouts-,

servos-, and solenoids.

The myRaillO decoders run on multiple cheap ESP32 micro controllers, each connected to
multiple cheap I/0 satellite FPGAs; All managed and supervised by a centralized
management software which in principle is OS independent (currently only evaluated with
Windows 11). The MyRaillO management software provides a Graphical User Interface for
overall MyRaillO configuration-, status-, alarm-, performance metrics-, and log/event
overview. Apart from a view of the current state of these metrics, the history of these metrics
is stored and can be viewed with associated time-stamps for later trouble-shooting and post-
mortem debug.

The design is entirely open source and licensed under the Apache version 2.0 license (ASLv2),
contribution of features-, code-, CI/CD-, testing-, trouble reporting and bugfixes is highly
appreciated.
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Features

MyRaillO features a scalable and distributed architecture for model train control peripherals such
as:

e Signal masts (any signal system supported by the Train controller)

e General Light groups where several (tri-colored) pixels work together creating various light
effects.

e Sensors (currently only digital sensors)

e Actuators (on/off, pulse, servos, solenoid, pwm)

Special attention has been paid to scalability and extensibility.

MyRaillO can easily be extended with new Light group effects such as multiple road work lights
playing in concert, or simulation of Television ambient flicker, etc. Although it currently only
integrates with the JMRI Train controller it should be straight forward to integrate with other Train
controllers. Scalability is achieved by adding more MyRaillO decoders and satellites, all managed
by one central MyRaillO server.

Although not redundant, the goal is to fail fast and reliably apply fail-safe measures avoiding unsafe
track movements and keeping the safety as a center pillow.

Moreover, MyRaillO supports the following features:

e Adecoder CLI for debugging.

e NTP time synchronization.

e RSyslLog for log aggregation and log rotation.
e Statistics and performance metrics.

e Alarms and alarm lists.
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High-level architecture

The architecture depicted below shows how myRaillO is composed of the central management
server, one or more MyRaillO decoders, each of them connected to zero or more I/O satellites.
These components interact with the Train controller which is responsible to issue Signal mast-,
light- and actuator- orders, as well as consuming sensor data. The main communication
procedures across these components are via MQTT - a light weight pub/sub bus, however Remote
Procedure Calls (RPC) are used in-between the MyRaillO management server and the Train

controller.
T
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MyRaillO Server

The MyRaillO (management) server is responsible for the configuration and management of the
underlying decoders. It is also the main integration point with various model railway controllers. It
communicates with the Train controller through Remote Procedure Calls (RPC) to exchange status
and configure the controller to directly communicate with the MyRaillO decoders. The RPC server
is a piece of software that implements a set of management and configuration methods defined by
the RPC client; these methods are used to exchange configuration and status information. The RPC
server runs in the context of the Train controller, and in the JMRI case it is implemented as a JMRI
Jython script.

To ensure low latency and high robustness the actual signal mast-, light-, actuator-, and sensor
information is communicated directly between the Train controller and the MyRaillO decoders
using MQTT and never via the MyRaillO server.

Another important aspect of the MyRaillO architecture is to maintain separation of concerns
between MyRaillO and the Train controller such that it is possible to integrate with other Train
controllers without impacting the core and protocols of MyRaillO, this is done by concentrating the
adaptations in the RPC server alone, acting as a shim layer.

The MyRaillO server is also responsible for configuring all the managed objects of the decoder and
otherwise, it provides a Graphical User Interface (GUI) for all of the configurations and pushes the
configuration to all of its decoders. It also keeps track of the status for all the managed objects,
provides an alarm list for the managed objects, and aggregates all the logs from the decoders.

The MyRaillO server and the related RPC components are allimplemented in Python and are in
principle platform/OS independent.

MyRaillO Decoders and Satellites

One or several MyRaillO decoders can be connected to a MyRaillO server wirelessly using
MQTT/IP/WiFi. The decoder implements all necessary supervision- and business logic to control
signal mast aspects, lights and light effects, actuators; as well as delivering sensor datain a
reliable and effective way.

The MyRaillO decoder runs on cheep ESP32 micro-controllers and is implemented in C++.

The following concepts are fundamental for the understanding and operation of MyRaillO and the
MyRaillO decoder.
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Light group and Light group link

A Light group is a set of LEDs or multi-color pixels that sits on a Light group link and together forms
some sort of managed object. Example: a signal mast with one or multiple signhal lights, a set of
road work warning lights with synchronized aspects, a multi-color pixel emulating television
ambient flicker, etc. The decoder does not itself have the notion of light group aspects or pixel
effects, the mapping between an aspect name and the actual behavior comes as configuration
data from the server. In that way, many types of Light groups can be defined and share the same
Light group link, and the signaling system used (Swedish, German, US, ...) is just a matter of
configuration. Although there is a limit to how many pixels the Light group link can carry, a set (more
than one) can sit on the same Light group link.

A Light group links is a serial link based on the WS2811/WS2812 protocol on which the light groups
sit. Up to two Light group links can be connected to a MyRaillO decoder.

Sensors, Actuators, Satellite and Satellite links

Many sensors and actuators can be connected to MyRaillO. These are connected to MyRaillO via
so-called Satellites. A sensor is currently a binary sensor (analogue sensors are on the to-do list),
up to 8 sensors can be connected to a MyRaillO satelite. Up to 4 actuators can be connected to a
MyRaillO Satellite. These actuator ports can be configured for various purposes such as: on/off,
pulse, solenoid, servo, pwm, etc.

As mentioned above, the MyRaillO satelite implements the sensor and actuator ports. One or more
Satellites can be connected to a Satelite link connected to the decoder. The Satellite link
implements a ring topology using a proprietary serial protocol where Satelite orders, meta-data,
and fault detection checksums are shifted out from the MyRaillO decoder, while sensor-, and fault
data is retrieved by the decoder in the other end of the SateliteLink. The Satellites monitors that
there are regular Satelite link polls, and if that is not the case — watchdog errors will be reported
back to the decoder. With this implementation, the Satelite link can be monitored for transmit- and
receive errors, watchdog errors, etc. Similarly, each satelite can be monitored for transmit-, receive
and watchdog errors that it has been impacted by. In case a Satelite experiences a receive error the
actuator state will remain the same as for the previous poll interval.

A MyRaillO decoder can connect up to two Satelite links.

The MyRaillO Satellites are implemented with a cheap FPGA implementation, see the open-source
project here jonasbjurel/genericlOSatellite: A model railway stackable and large scale sensor and

actuator framework (github.com)
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MyRaillO managed class/object model

MyRaillO implements a hierarchical managed class model where each class implements business-
, supervision-, and management logic for a certain resource type. Each managed class gets
instantiated in one or more managed objects with a certain configuration - operating and
supervising a particular resource instance (E.g., a sensor).

The following managed class models are defined: topDecoder, decoder, lightGroupLink,
lightGroup, sateliteLink, satelite, actuator, and sensor.

topDeoder

decoder

lightGroupLink sateLlitelink

lightGroup satellite

11

lightGroupType EladiEidely sensor

‘11 ' 1]

o

The managed Object Model is hierarchical with the cardinality as shown above. Each managed
object holds its own configuration with its own GUI- and CLI- context. All of the managed objects
except the topDecoder carry an object system name, an object username and an object
description collectively later referred to as “object identification”. The system name is a globally
unique non-mutable name which cannot be altered once configured, the object username is a lazy
descriptive name which can be altered at any time, just like the object description. For the
managed class objects which the Train controller need to be aware of - the system names need to
correspond between MyRaillO and the Train controller and need to adhere to the Train controller’s
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system name conventions, those managed class objects are: “lightGroup”, “actuator”, and
“sensor”; the Train controller is entirely unaware of the rest of the managed object classes.

topDecoder

The topDecoder management object is a singleton, unlike all the other managed objects it does not
manage any physical resources, but rather holds configurations common to the entire MyRaillO
setup, such as NTP-, RSysLog-, MQTT-, and RPC configurations and it is responsible for the server
communication.

decoder

The decoder managed object manages the configuration- and operations of a MyRaillO decoder. It
holds information such as the decoder identity (MAC Address)-, object identification-,
administrative blocking state-, operational state-, and various performance metrics of the decoder.

lightGroupLink

The lightGroupLink managed object manages the configuration- and operations of a MyRaillO
lightGroupLink. It holds information such as the object identification-, link number-, administrative
blocking state-, operational state-, and various performance metrics of the lightGroupLink.

lightGroup

The lightGroup managed object (like actuator and sensor) is a bit different than the others. In the
beginning it represents a “stem object” which has no DNA and is unaware of the actual type of Light
group it will eventually represent. At configuration of the Light group, it will in run-time inherit a
“lightGroupType” DNA class object which willimplement the actual functionality of the light-group.
Examples of a lightGrouplype is “signalMast” — more about this later.

The lightGroup managed object manages the configuration- and operations of a MyRaillO
lightGroup. It holds information such as the object identification-, lightGroup address,
administrative blocking state-, operational state-, current aspect, and various performance metrics
of the lightGroup.

satelliteLink

The satelliteLink managed object manages the configuration- and operations of a MyRaillO
satelliteLink. It holds information such as the object identification-, link number-, administrative
blocking state-, operational state-, and various performance metrics of the sateliteLink.
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satellite

The satellite managed object manages the configuration- and operations of a MyRaillO satellite. It
holds information such as the object identification-, satellite address-, administrative blocking
state-, operational state-, and various performance metrics of the satelite.

actuator

The actuator managed object is (like the lightgroup and sensor) a bit different than the others. In
the beginning it represents a “stem object” which has nho DNA and is unaware of the actual type of
Actuator it will eventually represent. At configuration of the Actuator, it will in run-time inherit a
“actuatorType” DNA class object which will implement the actual functionality of the actuator.
Examples of actuatorTypes are “actMem”-, “actLight”-, and “actTurn” — more about this later.

The actuator managed object manages the configuration- and operations of a MyRaillO actuator. It
holds information such as the object identification-, actuator port, administrative blocking state-,
operational state-, current position, and various performance metrics of the actuator.

sSensor

The sensor’s managed object is (like lightgroup and actuator) a bit different than the others. In the
beginning it represents a “stem object” which has no DNA and is unaware of the actual type of
Sensor it will eventually represent. At configuration of the Sensor, it will in run-time inherit a
“sensorType” DNA class object which will implement the actual functionality of the sensor. An
example of an “sensorType” is “sensDigital” — more about this later.

The actuator’s managed object manages the configuration- and operations of a MyRaillO actuator.
It holds information such as the object identification-, actuator port, administrative blocking state-,
operational state-, current position, and various performance metrics of the actuator.
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MyRaillO administrative-, and operational states

MyRaillO uses the concept of “administrative states” and “operational states”. Each managed
object has an “administrative state” and “operational state”.

The administrative state of a managed object is a result of a manual intervention — “Enabling” or
“Disabling” a managed object. By “Disabling” a managed object it is no longer operational, butin
maintenance mode - such that reconfiguration of the managed object is allowed. Any
reconfiguration during a “Disabled” maintenance period is never propagated to the actual
managed object resource until the managed object is “Enabled” through manual intervention. A
managed object cannot be reconfigured when “Enabled”. To “Disable” a managed object requires
that all subsequent hierarchical managed objects are “Disabled” — and thus out of operation. E.g.,
disabling a Satelite managed objects requires that all its actuators-, and sensors managed objects
are “Disabled” in forehand. A “Disabled” managed object triggers the “DABL” (Disabled)
operational state bit to be set for that managed object - securing that track movements related to
the disabled resources are forbidden - see operational states below.

The operational state of a managed object reflects the functional/error state of that managed
object. Operational states propagate down into all subsequent hierarchical management objects
such that if the parent managed object of a managed object has any of its operational state bits
set, the “CBL” (Control Blocked) operational state bit is set —which will trickle further down in the
managed object hierarchy. Operational state bits are set as a consequence of managed object
initialization-, managed object-, and managed object parent faults. Some examples of operational
state bits (more than one can be set at the same time):

e “INIT”: The managed object s initializing.

e “DISC”: The managed object is disconnected (l.e., from WiFi-, MQTT-, or RPC).

e "NOIP": The managed object has not been assigned an IP-address.

e “UDISC”: The managed object has not been discovered.

e “UCONF”: The managed object has not been configured.

e “DABL”: The managed object has been administratively “Disabled” — see above.

e "SUAVL": The MyRaillO server is missing excessive ping supervision messages from a decoder.

e "CUAVL": A MyRaillO decoder is missing excessive ping supervision messages from the server.

e “ESEC”: A Satelite link or a Satelite has experienced a second with extensive link errors.

e “ERR”: The managed object has experienced a recoverable error.

e “FAIL”: The managed object has experienced an unrecoverable error.

e “CBL”: The managed objectis control blocked due to errors higher up in the managed object
hierarchy.

e “UUSED”: The managed object is unused.
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Whenever a managed object has one of its operational status bits set it is considered non-
operational/un-safe, and consequently any physical resources related to the managed object are
set in a fail-safe mode - preventing any consequent unsafe train movements.

MyRaillO alarms

MyRaillO uses the concept of alarms. An alarm is a stateful event indicating a malfunction, an
alarm is raised whenever a malfunction appears, and is ceased when the malfunction situation
disappears. Alarms as such do not declare a managed object down, and do not trigger any fail-safe
operations — on the contrary alarms may be the result of a managed object operational state
transition that has triggered a failsafe operation, but an alarm does not by itself. Furthermore,
alarms do not necessarily relate to managed objects, but may be connected to any logic failures
that have a stateful property (the failure can come and go).

Alarms comes with three different severities:

e “A”: ACritical alarm indicating that certain MyRaillO services may be inoperative all together.
e “B”: ANon-critical alarm indicating that certain MyRaillO services maybe degraded in its
operations.
e “C”: Anotice alarm indicating that certain MyRaillO services may be limited in their
functionality, but in no way impacting the operations.

MyRaillO alarms are captured and stored in an alarm-list, the alarm-list captures active alarms, as
well as all historical inactive/ceased alarms with: Alarm Id, Severity, Raise-time, Cease-time,
duration, Alarm-type, Alarm-source, Alarm-slogan, Alarm-raise reason, and Alarm-cease reason.

At current, the alarm-Llist is volatile and resets after each MyRaillO server restart.

MyRaillO resiliency, reliability, and track safety

MyRaillO is its nature inherently non redundant, a failure in one of its components caused by
unrecoverable software-, communication-, or configuration errors will lead to disruption of the
MyRaillO operations — and thereby inability to set signal mast aspects, actuators, and detect
sensorinputs. The strategy to manage such faults is to “fail fast”, and in these failure scenarios
have several layers of software error exemption handlers that tries to apply the proper fail-safe
mechanisms including:

e Setting Signal masts, Turnouts and Actuators in a failsafe position.
e Setting the sensorvalues reported to the Train controller in a failsafe position.
e Optionally turning of the track power.
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To early detect errors, MyRaillO implements several layers of supervision and fault detection

mechanisms:

e Each process-, task-, and poll-loop is supervised by watch dogs.
e Allcommunication paths are supervised by keep-alive supervision messages.
e Allcommunications have checksums appended.
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Hardware
The hardware is not currently part of this project, we may later decide to create printed circuit

The decoder pin-outis as follows:

Signal: ESP32 PIN: | Comment:
LGLINK_TX_CHANNEL_0O 25

LGLINK_TX_CHANNEL_1 26

SATLINK_TX_CHANNEL_O 18

SATLINK_RX_CHANNEL_1 19

SATLINK_TX_CHANNEL_0 21

SATLINK_TX_CHANNEL_1 292

PROVISIONING_BUTTON 27 Active low

The satelite hardware and pin-out is described here: jonasbjurel/genericlOSatellite: A model

railway stackable and large scale sensor and actuator framework (github.com)
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Usage

This section assumes a correct installation of JIMRI, MyRaillO, and an MQTT broker (See the
installation section further down).

Setting up an MQTT Server

My RaillO depends on an MQTT (Message-bus) broker service. MQTT is the way the MyRaillO- and
JMRI- server communicates with the MyRaillO decoders. A good choice is to use the “mosquitto”
MQTT broker which runs on multiple OSes and is free of charge.

Setting up JMRI for MyRaillO operations

JMRI needs to be set up to work with MyRaillO.

JMRI must be configured to interwork with your MQTT broker. From JMRI PanelPro go to
“edit/preferences”:

e Select “MQTT” as system manufacturer.

e Select “MQTT Connection” as the System connection.

e Provide the IP-address for your MQTT broker.

e Andfillin the prefix, the connection name, and the topics as shown below.

e Finally select Save.

JMRI must also be configured to run the MyRaillO RPC server. From JMRI PanelPro go to
“Scripting/Run Script” and select the “myRailloRpcServer.py” file found under: “server/scripts/rpc”
in the MyRaillO repository.
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This concludes the set-up of JIMRI for MyRaillO operations.

Setting up MyRaillO preferences

Start the “myRaillOd.py” Python program found under “server/Scripts/myRaillO” in the MyRaillO
repository. This will cause the MyRaillO Graphical User Interface (GUI) to pop up:

Object navigation:

Right-click on the topDecoder object and select “Edit”:
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Author: Jonas Bjurel
Config description: Sample config for Demo purposes
Config version: 0.0.1 Version date: 2024-08-18
git URI: my.git.com
git branch: gittag: Tip
git Commit git Check-out

RPC URL: 127.00.2 RPC port base: 8000
RPC keep-alive (s): 10,0 -
MQTT URL: 192.168.2.129 MQTT Port: 1883
MQTT Topic pre-fix: ftrains
MQTT Ping-period (s): 10,0 - MQTT Keep-alive (s): 60
NTP URL: pool.ntp.org Time Zone: Etc/UTC
RSyslog URL: 192.168.2,129 Log verbosity: INFO
RSyslog File: myRaill0.log
Logrotate # files: 3 L Logrotate file size (KB): 500

B Decoder failsafe B Tracks failsafe
Admin, state; DISABLE Recursive
Operational state: UNAVA Details: DABL
Up-time (min):

View XML configuration 0K Cancel

Edit configuration meta data such as “Author”, “Description”, “Version”, and date. The git fields are
for future git operations and are not yet implemented.

Edit the RPC parameters:

e “RPC URL”isthe URL or the IP address of the JMRI RPC server, if JIMRI runs on the same host as
the MyRaillO server, at current only “127.0.0.2” is supported - l.e. JMRI and MyRaillO needs to
run on the same host.

e “RPC port base” is the starting port in a series of ports used for the RPC communication
(currently 2). Use 8000 as that is currently a hardcoded value in the RPC server.

e “RPC keep-alive” is the RPC supervision keep-alive period. After three consecutive missed
keep-alive messages the RPC session is deemed down. Shortening the keep-alive period allows
for faster RPC fault detection. The recommended value is in-between 1- and 10 seconds
depending on fault detection needs.

Edit the MQTT parameters:

e “MQTT URL” is the URL or the IP address of the MQTT broker, if the MyRaillO server runs on the
same host as the MQTT broker, “localhost” or “127.0.0.X” can be used. For Demo purposes the
cloud demo service “test.mosquitto.org” can be used.

e “MQTT port”is the MQTT destination port. 1883 is the standard MQTT port.
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e “MQTT Topic pre-fix” defines a string used as a standard MQTT topic pre-fix. “/trains” is typically
used for MQTT.

e “MQTT Ping-period” defines the end to end (server-decoder) ping supervision period. After three
consecutive missed ping messages the decoder connection is deemed down. Shortening the
ping period allows for faster decoder fault detection. The recommended value is in-between 1-
and 10 seconds depending on fault detection needs.

e “MQTT Keep-alive” defines the server to MQTT broker keep-alive supervision period. After three
consecutive MQTT keep-alive messages the MQTT session is deemed down. Shortening the
keep-alive period allows for faster MQTT fault detection. The recommended value is in-between
10- and 60 seconds depending on fault detection needs.

Edit the time parameters:

e “NTP URL” defines the NTP server that decoders will synchronize time with.
e “Time Zone” defines the local time-zone which the decoders should use.

Edit the RSyslog parameters:

e “RSyslog URL” defines the SysLog server URL/IP-address to which the decoders should send
their logs. If the URL/IP-address is the same as used by the MyRaillO server, the logs will be sent
to the Server’s built-in RSyslog server, and all logs will be visible from the MyRaillO server.

e “lLogverbosity” sets the verbosity of all logs: Including Decoder logs, Server Logs, and RPC
server logs.

e “RSyslogfile” defines the log base file name and path. All logs from the built-in RSyslog servers
will be written to this file.

e “Logrotate # Files” Defines number of files for which the RSyslog servers should logrotate.

e “Logrotate file size” Defines the size of the log file before logrotate happens.

Enable or disable decoder failsafe by clicking/un-clicking the “Decoder failsafe” check-box. Set all
decoders- and decoder's objects in fail-safe if an error exists - no matter where in the object
hierarchy the error resides. [NOT IMPLEMENTED]

Enable or disable Tracks failsafe by clicking/un-clicking the “Tracks failafe" check-box. Turns off
track power if an error exist - no matter where in the object hierarchy the error resides [NOT
IMPLEMENTED]

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.
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Click “Accept” to accept the configuration.

If you have not already enabled the Top decoder, right-click on the decoder object and select
“Enable”. If the configuration is correct, the topDecoder object should turn color from grey to green
as shown below, this means that the decoder’s operational state is “Available”.
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Configuring and onboarding a MyRaillO decoder

Before a MyRaillO decoder can be discovered and onboarded by the MyRaillO server it needs to be
provisioned with some day-0 configuration. This is done through a provisioning web portal server
residing on the decoder. This portalis enabled by pressing the decoder’s provisioning button for
~50 seconds after resetting the decoder — see the Hardware section to identify the provisioning
button. This will erase all the configuration of the decoder; it will start a local WiFi access point and
the provisioning portal. The Access point SSID starts with “myRaillOConfAP_” followed by the
decoders MAC address.

%@ BREVIK_INTRANET
> BREVIK_OPEN

%8 BREVIK_EXTRANET

= myRaillOconfAP_E0:E2:E6:4C:13:30

%@ Hidden Network

Wi-Fi settings

Connect to the Decoder’s WiFi and open a Web browser, if the browser does not re-direct to the
provisioning portal, enter 10.0.0.2 in the browser’s address field.

myRaillO decoder
configuration manager

myRailIOconfAP_EO:E2:E6:4C:13:30

Configure WiFi

Update

No AP set
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Select “Info” to capture the MAC address of the decoder as part of the SSID shown on the top of the
page, you will need it later.

BREVIK_INTRANET aal
BREVIK_EXTRANET &l
BREVIK_2_4_G_LAB aal

BREVIK_OPEN o
DaikinAP03185 a.

SSID
[ BREVIK 2 4 G_LAB

Password

.
:
:
:
:
:

() Show Password

Static IP

[

Static gateway

[

Subnet

[

Static DNS

[

HostName

[esp32-4c1330 ]
MQTTserverURIL

(192.168.2.129 ]
MQTTserverPort

1883 ]
| No AP set

Select one of the shown WiFi SSIDs or type in one manually, enter the WiFi password. If none of the
static address fields are entered - DHCP will be used, otherwise static addresses will be used.
Enter the “MQTTserverURI” and “MQTTserverPort” which should be the same as was provided for

the topDecoder configuration.
Press “Save”
The decoder should now be provisioned for on-boarding with the MyRaillO server.

Go back to your previous/normal WiFi SSID.
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From the MyRaillO Server GUI - right-click on the topDecoder object and select “Add” and then
select “Decoder”.

& myRaillo = o X
File Edit View Tools Inventory Debug Help
Object navigation:

& tg

Add

View

Disable

Disable - recursive

When adding a decoder to the topDecoder, a decoder configuration dialog will appear. Fill in the
configuration as follows:

System name: GID-MyUserGuideDecoderDemo

User name: MyUserGuideDecoderDemoUsr

URI: decoder0.myrail.io

MAC Address: E0:E2:E6:4C:13:30

Description: MyUserGuideDecoderDemoUsr

HW Version: - FW Version: -

IP Address: = Launch GUI Launch CLI
Operational state: UNAVAIL Details: NIT|DISC|NOIP|UDISC|UCONF|DABL
Up-time (min): 0 “d":f" DISABLE () Recursive

| 0K Cancel

e “System name” This is an immutable system identifier that needs to begin with the “GJD-“ pre-
fix. As the MyRaillO Decoder concept is unknown to the Train controller, this system identifier
will also be un-known to the Train controller.

e “Username” defines a lazy user name for the decoder.

e “URI” Defines the decoder URI used for MQTT message addressing. It does not need to be
resolvable by any DNS, but it needs to be unique for the MyRaillO deployment, and it needs to
follow the URI format: <resource>.<domain>.<topDomain>

e “MAC Address” defines the MAC address of the decoder as we recorded when we provisioned
the decoder, alternatively you can find the decoder MAC in the decoder inventory view:
“Inventory”->"Show Decoders inventory”.
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e “Description” provides a description of the decoder.

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.

Click “Accept” to accept the configuration.

A somewhat easier way to configure a decoder is to go to the decoder inventory view: “Inventory”-
>”Show Decoders inventory” and select the decoder you want to configure (It should show in blue -
meaning that it is an unconfigured decoder) and right-click on it, now the configuration view will
show with the MAC address pre-filled.

If you have not already enabled your newly configured decoder, right-click on the decoder object
and select “Enable”. If the configuration is correct, the Decoder object should after a while turn
color from grey to green as shown below, this means that the decoder’s operational state is
“Available”. In the background a decoder configuration will be compiled from all relevant managed
objects and pushed to the decoder after the decoder has been restarted.
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Adding and configuring a MyRaillO Light group link

The MyRaillO Light group link concept is fundamental for MyRaillO Light groups, itis the carrier of
Light group aspect information and represents the physical link for that information. Many Light
groups may share the same Light group link, and a MyRaillO decoder can connect up to two Light
group links.

To add a Light group link — go to MyRaillO Server GUI - right-click on the decoder object to which
you want to connect the Light group link - select “Add” and select “Light group link”.

A myRailo - D X

File Edit View Tools Inventory Debug Help

Object navigation:

v & topDecoder
Decoc | ad juideDecoderDemo

View

Disable

Disable - recursive

Restart

When adding a Light group link to a decoder, a Light group link configuration dialog will appear. Fill
in the configuration as follows:

&

System name: GILL-MyUserGuideLgLinkDemo Link number: 0
User name: MyUserGuideLgLinkDemoUsr

Description: MyUserGuideLgLinkDemoDesc

Mast definition path: C:\Program Files (x86)\JMRI\xml\signals\Sweden-3HMS

Operational state:  UNAVAIL Details: INIT|UCONF|DABL
- . Admin. .
- . [
Up-time (min): s DISABLE Recursive
0K Cancel

e “System name” This is an immutable system identifier that needs to begin with the “GJLL-“ pre-
fix. As the MyRaillO Light group link concept is unknown to the Train controller, this system
identifier will also be un-known to the Train controller.

e “Username” defines a lazy user name for the Light group link.

e “Description” provides a plane description of the Light group link.
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e “Link number” defines the physical Light group link connected to the decoder. See the HW
section for link number pin-out.

e “Mast definition path” defines the path to the Train controller’s signaling system definitions, this
path is relative to the Train controller’s (JMRI) path on the train controller host, and not relative
to the MyRaillO server path/host. In fact, these signaling mast definitions are pulled via the RPC
interface from the Train controller host. As signal masts are just one type of Light groups, we
could argue why this definition resides under the Light group link. However, these definitions
tend to be quite large making it unpractical to have them defined per signal mast Light group
definition. This means that on the same Light group link, only one signaling system (Sweden,
Germany, US) may occur which is not a real issue. The issue is more of an architectural
conceptual issue, as these definitions really do not have a place in the Light group link managed
objects. This may change over time.

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.

Click “Accept” to accept the configuration.

If you have not already enabled your newly configured Light group link, right-click on the Light group
link object and select “Enable”. If the configuration is correct, the Light group link object should
after a while turn color from grey to green as shown below, this means that the Light group link’s
operational state is “Available”. In the background a decoder configuration will be compiled from all
relevant managed objects and pushed to the decoder after the decoder has been restarted.

Version: 0.0.1c Date: 2024-08-18



MyRaillO
User guide

Adding and configuring a MyRaillO (Signal mast) Light group

The MyRaillO Light group concept provides a powerful way to combine one or several monochrome
or tri-colored pixel elements into one managed object, which can illuminate the various pixels in a
concert, creating all kind of light effects-, and aspects — controlled by the Train controller.

To add a Light group —go to MyRaillO Server GUI - right-click on the Light group link object to which
you want to connect the Light group - and select “Add” and select “Light group”.

& myRaillo — a x
File Edit View Tools Inventory Debug Help
Object navigation:

v & topDecoder
Decoder-GID-MyUserGuideDecoderDemo
|8 LgLink_~1 1 _M..1i——2yjied] gLinkDemo

Add I

Disable
Disable - recursive

When adding a Light group to a Light group link, a Light group configuration dialog will appear. Fillin
the configuration as follows:

r
| 8
JMRI system name: [F$vsm:Sweden-3HMS:SL-5HL($0001)
JMRI user name: MyUserGuide5SHLMastLgDemoUsr

JMRI description: MyUserGuideSHLMastLgDemoDesc

Link Address: o

Type: SIGNAL MAST

Mast type: Sweden-3HMS:SL-5HL

Diming time: NORMAL

Flash freq.: NORMAL

Operational state: UNAVAIL Details: INIT|UCONF| DABL
Up-time: 0 Admin. state: DISABLE - Recusive

Light group showing: UNKOWN

OK Cancel
L d
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e “Type” Start with selecting the type of Light group type, at current “SIGNAL MAST” is the only
supported Light group type. Common for all Light group types is that the fail-safe
aspect/signature is all lights on.

e “JMRI system name” This selection box will now show all the signal masts already defined in
JMRI but not yet defined in MyRaillO, you can pick one of them or you can define your own which
will then be populated in JMRI. If you chose to define your own go and select your mast type in
the “Mast type” selection box and a template system name will appear in the “JMRI system
name” selection box, edit the “($nnnn)” field with a unique 4 digit signal mast identifier number.
Note that the “JMRI system name” must have the following format: IF$vsm:<signal system
type>:<signal mast type>($<nnnn>), where <nnnn> must be an unique 4 digit number.

e “JMRIuser name” defines the lazy user name of the signal mast. If an already defined JMRI
signal mast is picked from the “JMRI System name” selection box, the “JMRI user name” is auto-
filled.

e “JMRI description” provides a description of the signal mast. If an already defined JMRI signal
mast is picked from the “JMRI System name” selection box, the “JMRI description” is auto-filled.

e “Link Address” Defines the address on the Light group link on which the Light group is attached
to. That is the sequence number of the Light group starting from the beginning of the Light group
link.

e “Masttype” Defines one of the signal mast types defined by the signal system type defined by
the Light group link. If an already defined JMRI signal mast is picked from the “JMRI System
name” selection box, the “Mast type” is auto-filled.

e “Dimmingtime” Defines the emulated bulb filament dimming time.

e “Flash freq.” Defines the flashing frequency for flashing aspects.

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.

Click “Accept” to accept the configuration.

If you have not already enabled your newly configured Light group |, right-click on the Light group
object and select “Enable”. If the configuration is correct, the Light group object should after a
while turn color from grey to green as shown below, this means that the Light group link’s
operational state is “Available”. In the background a decoder configuration will be compiled from all
relevant managed objects and pushed to the decoder after the decoder has been restarted.
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From JMRI PanelPro go to “Tools”->“Tables”->“Signals”->“Signal Masts” and select an aspect for
your newly configured Signal mast, the corresponding aspect should now show on your physical

Signal mast.

P& Signal Masts = a X
File View Tools Window Help

Tumouts 4 5 ctem name User Name Aspect Comment Lt Hed
Sensors »

Signal Heods

signal Groups Add...
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Adding and configuring a MyRaillO Satellite link

The MyRaillO Satellite group link concept is fundamental for MyRaillO Satellites, Sensors and
actuators; it is the carrier of Satellite control information as well as Sensor and Actuator
information and represents the physical link carrying that information. Many Satellites may share
the same Satellite link, and a MyRaillO decoder can connect up to two Satellite links.

To add a Satellite link — go to MyRaillO Server GUI -right-click on the decoder object to which you
want to connect the Satellite link - select “Add” and select “Satellite link”.

A myRailo - D X

File Edit View Tools Inventory Debug Help

Object navigation:

v & topDecoder
Decoc | ad juideDecoderDemo

View

Disable
Disable - recursive

Restart

When adding a Satellite link to a decoder a Satellite link configuration dialog will appear. Fillin the
configuration as follows:

System name: GJSL-MyUserGuideSatLinkDeme  Link number: 0
User name: MyUserGuideSatLinkDemoUsrName

Description: MyUserGuideSatLinkDemoDesc

RX CRC errors: 0 Remote CRC errors: 0
RX Size errors: 0 RX Symbol errors: 0

Watchdog errors:

Update statistics Clear statistics

Operational state:  UNAVAIL Details: INIT|UCONF|DABL
" " Admin.
= B C (
Up-time (min): 0 state: DISABLE _| Recurs
OK  Cancel

e “System name” This is an immutable system identifier that needs to begin with the “GJSL-“ pre-
fix. As the MyRaillO Satellite link concept is unknown to the Train controller, this system
identifier will also be un-known to the Train controller.
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e “User name” defines a lazy user name for the Satellite link.
e “Description” provides a plane description of the Satellite link.

e “Link number” defines the physical Satellite link connected to the decoder. See the HW section
for link number pin-out.

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.

Click “Accept” to accept the configuration.

If you have not already enabled your newly configured Satellite link, right-click on the Light group
link object and select “Enable”. If the configuration is correct, the Satellite link object should after a
while turn color from grey to green as shown below, this means that the Satellite link’s operational
state is “Available”. In the background a decoder configuration will be compiled from all relevant
managed objects and pushed to the decoder after the decoder has been restarted.
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Adding and configuring a MyRaillO Satellite

The MyRaillO Satellite concept provides a distributed concentrator for Sensors and actuators, and
sits on an MyRaillO Satelite link.

To add a Satellite — go to MyRaillO Server GUI -right-click on the Satelite link object to which you
want to connect the Satellite - select “Add” and select “Satellite”.

A

Object navigation:

v & topDecoder
v & Decoder-GID-MyUserGuideDecoderDemo
& LgLink-GILL-MyUserGuideLgLinkDemo
& SatLink-GISL-MyUserGuideSatLinkDemo

Satellite

oK Cancel

When adding a Satellite to a Satelite link a Satellite configuration dialog will appear. Fillin the
configuration as follows:

™
System name: GISAT-MyUserGuideSatDemo Address: 0
User name: MyUserGuideSatDemoUsrName
Description: MyUserGuideSatDemoDesc
RX CRC errors: 0 TX CRC errors: 0

Watchdog errors: 0

Update statistics Clear statistics

Operational state: ~ UNAVAI Details: INIT|UCONF|DABI
Up-time (min): 0 dmeny DISABLE ~ [ Recursive
) state: —

OK  Cancel

e “System name” This is an immutable system identifier that needs to begin with the “GJSAT-“
pre-fix. As the MyRaillO Satellite concept is unknown to the Train controller, this system
identifier will also be un-known to the Train controller.

e “User name” defines a lazy user name for the Satellite.

e “Description” provides a plane description of the Satellite.
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e “Address” Defines the address on the Satelite link on which the Satelite is attached to. That is
the sequence number of the Light group starting from the end of the Light group link, NOTE
THAT IN CONTRATORY TO LIGHT GROUPS ON THE LIGHT GROUP LINK, THE ADDRESSING
OF SATELITES ON THE SATELITE LINK IS COUNTING FROM THE END (TERMINATION) OF THE
SATELITE LINK.

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.

Click “Accept” to accept the configuration.

If you have not already enabled your newly configured Satelite, right-click on the Satelite object and
select “Enable”. If the configuration is correct, the Satellite object should after a while turn color
from grey to green as shown below, this means that the Light group link’s operational state is
“Available”. In the background a decoder configuration will be compiled from all relevant managed
objects and pushed to the decoder after the decoder has been restarted.
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Adding and configuring a MyRaillO Sensor

The MyRaillO Satelite concept provides distributed Sensor capabilities.

To add a Sensor — go to MyRaillO Server GUI - right-click on the Satelite object to which you want to
connect the Sensor - and select “Add” and select “Sensor”.

A

Object navigation:
v & topDecoder
Decoder-GID-MyUserGuideDecoderDemo
& LgLink-GILL-MyUserGuideLgLinkDemo
v & SatLink-GJSL-MyUserGuideSatLinkDemo
A Sat-GISAT-MyUserGuideSatDemo

LLLLLL

When adding a Sensor to a Satelite, a Sensor configuration dialog will appear. Fillin the
configuration as follows:

JMRI system name: MS-MyUserGuideSensorDescription
JMRI user name: MyUserGuideSensorDescriptionUsrName

JMRI description: MyUserGuideSensorDescriptionDesc

Sensor port: 0o - Sensor type: DIGITAL
Operational state: UNAVAIL Details:
P ; Admin. ( 2
| Up-time: 0 e DISABLE || Recursive
Sensor sensing: INACTIVE
|
OK  Cancel

e “JMRI system name” This selection box will now show all the Sensors already defined in JMRI
but not yet defined in MyRaillO, you can pick one of them or you can define your own which will
then be populated in JMRI. If you chose to define your own it needs to start with the “MS-“ pre-
fix.

e “JMRIuser name” defines the lazy user name of the Sensor. If an already defined JMRI Sensor is
picked from the “JMRI System name” selection box, the “JMRI user name” is auto-filled.
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e “JMRI description” provides a description of the Sensor. If an already defined JMRI Sensor is
picked from the “JMRI System name” selection box, the “JMRI description” is auto-filled.

e “Sensor port” Defines the Sensor port on the Satelite on which the Sensor is attached to.

e “Sensortype” Defines the Sensor port type — “DIGITAL” is currently the only supported sensor
type. The fail-safe position is ? [TODO: PAYLOAD IS FAILSAFE, HOW IS THAT INTERPRETED BY
JMRI?]

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.

Click “Accept” to accept the configuration.

If you have not already enabled your newly configured Sensor, right-click on the Satelite object and
select “Enable”. If the configuration is correct, the Sensor object should after a while turn color
from grey to green as shown below, this means that the Sensor’s operational state is “Available”. In
the background a decoder configuration will be compiled from all relevant managed objects and
pushed to the decoder after the decoder has been restarted.

From JMRI PanelPro go to “Tools”->“Tables”->“Sensors” and watch the state of the newly created
Sensor - it should follow the input to your newly configured physical sensor.

Adding and configuring a MyRaillO Actuator

The MyRaillO Satelite concept provides distributed Actuator capabilities.

To add an Actuator — go to MyRaillO Server GUI - right-click on the Satelite object to which you want
to connect the Actuator - and select “Add” and select “Actuator”.
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Object navigation:
v & topDecoder
v 2 Decoder-GID-MyUserGuideDecoderDemo
& LgLink-GILL-MyUserG nkDemo
v & SatLink-GISL-MyUs:
v N Sat-GISAT-MyUser

eSatLinkDemo
atDemo

Actuator

When adding an Actuator to a Satelite, an Actuator configuration dialog will appear. Fill in the
configuration as follows:
JMRI description: MyewT urnoutDescription

Actuator type: TURHOUT

Actuator sub-type: SOLENOD
Operational state: Details:

Up-time (min): Admin. state: DISABLE Recusive

Actuator position:

“Actuator type”: Start by defining the actuator type, select between Turnout, Light, or Memory.
This will select to which JMRI control mechanism the actuator will be connected.

O “Turnout” connects the actuator to JMRI’s Turnout control mechanism. In this mode the

“JMRI System name” must start with the “MT-“ pre-fix. Turnout allows two “Actuator sub-
types”: “SOLENOID” and “SERVO”.

B “SOLENOID” Controls a normal solenoid maneuvered servo, this sub-type
requires two actuator ports, one to maneuver the turnout into closed position,
and one to one to maneuver the turnout into thrown position. The two ports must
be adjacent to each other and start with an even port number. [TODO: Fail-safe
position is not settable].

|

“SERVO” Controls a servo maneuvered servo, to make the turn move more

realistic the turn movement time is 1 second. Fail-safe position is closed. [TODO:
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There is currently no trim or variable end limitations, nor is there an
adjustable turnout move velocity, or settable fail-safe position].

“Light” connects the actuator to JMRI’s Light control mechanism. In this mode the “JMRI
System name” must start with the “ML-“ pre-fix. Light only allows ON/OFF operations.
The fail-safe setting is OFF.

“Memory” connects the actuator to JMRI’'s Memory mechanism, such that the actuator
is controlled by the JMRI memory content of “JMRI System name”. In this mode the “JMRI
System name” must start with the “IM-“ pre-fix. “MEMORY” is the most powerful
actuator mode and allows six “Actuator sub-types”: “SOLENOID”, “SERVO”, “PWM1007”,
“PWM1_25K”, “ONOFF”, “PULSE”".

“SOLENOID” uses two ports, one to move the solenoid in one position, and the
other to move the solenoid to the other position. The two ports must be adjacent
to each other and start with an even port number. If the memory variable contains
the “ON” the odd port will be active for 200 ms, if it contains “OFF” or any other
value the even port will be activated for 200 ms. The fail-safe setting is “OFF”.
[TODO: Fail-safe position is not settable, invert is not supported].

“SERVER” turns a servo. The Servo moves clockwise from the memory value 0 to
255. The fail-safe setting is “0”. [TODO: There is currently no trim or variable
end limitations, nor is there an adjustable servo move velocity - currently
instant, fail-safe position is not settable, invert is not supported].

“PWM100” provides a 100 Hz PWM signal. The PWM duty period varies with the
memory value from 0 to 255. Failsafe positionis 0. [TODO: There is currently no
trim or variable end limitations, nor is there an adjustable PWM move
velocity — currently instant, fail-safe position is not settable, invert is not
supported].

“PWM1_25” provides a 1.25 kHz PWM signal. The PWM duty period varies with the
memory value from 0 to 255. Failsafe position is 0. [TODO: There is currently no
trim or variable end limitations, nor is there an adjustable PWM move
velocity — currently instant, fail-safe position is not settable, invert is not
supported].

“ON/OFF” provides a simple on/off operation, if the memory position contains
“ON” the actuator is activated, if it contains “OFF” or any other values the
actuator is inactivated. The fail-safe position is “OFF”.

[TODO: Fail-safe position is not settable, invert is not supported].

“PULSE” provides a pulse whenever the memory value is changed. The pulse
length is from 0-255 ms and follows the content of the memory value. The fail-
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safe position is 0. [TODO: Fail-safe position is not settable, invert is not
supported].

® “JMRI System name” Once you have set the “Actuator type”, you may associate your Actuator
with actuators already defined in JMRI through the “JMRI System name” selection box, or you
can crate a new one by entering your own “JMRI System name” providing that you adhere to the
“JMRI System hame” haming convention as described above. In case you create a new Actuator
not defined in JMRI, MyRaillO will create it in JMRI for you.

e “JMRIuser name” defines the lazy user name of the Actuator. If an already defined JMRI
Actuator is picked from the “JMRI System name” selection box, the “JMRI user name” is auto-
filled.

e “JMRI description” provides a description of the Actuator. If an already defined JMRI Actuator is
picked from the “JMRI System name” selection box, the “JMRI description” is auto-filled.

e “Actuator port” Defines the Actuator port on the Satelite on which the Actuator is attached to. In
case the Actuator requires several ports, this defines the base (tarting)- port.

The administrative state can be changed to “ENABLE” in the “Admin. state” selection box. If the
“Recursive” check-box is checked, the administrative state of all child objects will assume the
same administrative state.

Click “Accept” to accept the configuration.

If you have not already enabled your newly configured Actuator, right-click on the Actuator object
and select “Enable”. If the configuration is correct, the Actuator object should after a while turn
color from grey to green as shown below, this means that the Actuator’s operational state is
“Available”. In the background a decoder configuration will be compiled from all relevant managed
objects and pushed to the decoder after the decoder has been restarted.

From JMRI PanelPro go to “Tools”->“Tables”->“Turnouts”-, “Tools”->“Tables”->“Lights”-, or “Tools”-
>“Tables”->“Memory Variables” and set the state of the newly created Actuator —to watch the

physical Actuator to move accordingly.

MT-MyNewTurnoutSysName My MewTurnoutUsrMame MyNewTurnoutDescription

Add... ) Automatic retry [ Show Feedback information (] Show Lock information (] Show Tumout Speed details [T Show State Query actions
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Understanding, and working with MyRaillO configurations

The above descriptions give an insight into how to configure MyRaillO and all its components. The
resulting configuration can be saved by selecting “File”->"Save as” to save a new configuration or
“File”->"Save” to modify a configuration which was previously loaded through “File”->"Open”.

Once a configuration has been saved it can always be retrieved by selecting “File”->"Open”.

& myRaillo - o x

File Edit View Tools Inventory Debug Help
Open S
Save .IOI'I.

Save as

Auto-load preferences  JD-MyUserGuideDecoderDemo
& LgLink-GILL-MyUserGuideLgLinkDemo
~ & SatLink-GJSL-MyUserGuideSatLinkDemo
v | Sat-GISAT-MyUserGuideSatDemo

=

To avoid the need for manually having to open the configuration when ever you start your model
railway (assuming you have arranged some kind of auto-start of MyRaillO), you can define a
configuration auto-load profile by selecting “File”->"Auto-load preferences”

Auto-load configuration file: Yes v
Auto-load configuration file delay (s): 10 =
0K Cancel

By Setting “Auto-load configuration file” to “Yes” the current loaded/saved configuration file will be
loaded after “Auto-load configuration file delay” seconds.

The configuration is in XML format and can be edited off-line by hand or by any type of script. The
MyRaillO API reference guide [Ref. XXXX] provides the expected configuration format and XML
Key/Values.

In the MyRaillO GUI, you can always view the current resulting XML configuration by selecting
“View”->”Configuration”, or by clicking the “View XML configuration” button in the topDecoder
object configuration dialog.
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& myRaillo

File Edit View Tools Inventory Debug Help
= Configuration |

Objec . 15

Ja
v & topDecoder
Decoder-GID-MyUserGuideDecoderDemo

The thoughts for the future are to enable git version control of the MyRaillO configurations such that
configurations can be version controlled and managed by remote git repositories such as github,
gitlab, or your own git repository. As this is not yet in place, you may save your configurations to
your own local git repository and push it to a remote git repository as you wish.
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Understanding, and working with MyRaillO administrative- and operational
states

Each of the MyRaillO objects in the object tree has an Administrative and an Operational state
shown in its respective configuration dialog.

The Administrative state is set to “ENABLE” or “DISABLE” as a manual intervention. When disabled
the MyRaillO object is not operational, and Fail-safe actions are applied. (Re-)configuration of an
object is only allowed when the object is “DISABLED”, and although the new configuration is
available in the MyRaillO server and can be persisted by saving it, it is not pushed to the decoders
until the object is “ENABLED” - also leading to a restart of the decoders. An MyRaillO object may
not be “ENABLED” unless its parent is “ENABLED?”, similarly an object may not be “DISABLED”
unless all its children are “DISABLED”. If you want to avoid manually “ENABLE” all parents, or
“DISABLE” all children you may use the “recursive” version of “ENABLE”/”DISABLE” in which case
the server does it for you. “ENABLE”/”DISABLE” a MyRaillO object by right-clicking on it in the
object tree dialog and select “Enable”/”Enable - recursive” or “Disable”/”Disable — recursive”.

A myRaillo - a %

File Edit View Tocls Inventory Debug Help

Object navigation:

v & topDecoder
v 2 Decoder-GID-MyUserGuideDecoderDemo
& LgLink-GJLL-MyUserGuideLgLinkDemo
v & SatLink-GJSL-MyUserGuideSatLinkDemo
v X Sat-GISAT-MyUserGuideSatDemo

e

The operational state provides the operational state of a MyRaillO object, it may represent an error
state of the object, an error state of the parent object, or the fact that the object is administratively
“DISABLED”. The operational state of an object can be viewed in each of the object configuration
dialogs. The “Operational state” shows a summary “AVAIL”/”UNAVAIL” while the “Details” shows all
of the current operational state bits with the following meaning:

e “INIT”: The managed object is initializing.

e “DISC”: The managed object is disconnected (l.e., from WiFi-, MQTT-, or RPC).
e "NOIP": The managed object has not been assigned an IP-address.

e “UDISC”: The managed object has not been discovered.

e “UCONF”: The managed object has not been configured.
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e “DABL”: The managed object has been administratively “Disabled” — see above.

e "SUAVL": The MyRaillO server is missing excessive ping supervision messages from a decoder.

e "CUAVL": A MyRaillO decoder is missing excessive ping supervision messages from the server.

e “ESEC”: A Satelite link or a Satelite has experienced a second with extensive errors.

e “ERR”: The managed object has experienced a recoverable error.

e “FAIL”: The managed object has experienced an unrecoverable error.

e “CBL”: The managed object is control blocked due to errors higher up in the managed object
hierarchy.

e “UUSED”: The managed objectis unused.

Whenever a MyRaillO object has a non-working operational state, the CBL operational state bit will
be set to allits children.

The color of the objects in the object tree view summarizes the administrative- and operational
state of the objects: Grey means administratively “DISABLED”, Green means operationally “AVAIL”,
Red means operationally “UNAVAIL”, and yellow means “CBL” (Its parent is not “AVAIL”).

Object navigation: L4

v & topDecoder
v = Decoder-GJD-MyUserGuideDecoderDemo

v g
EN

&
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Understanding, and working with MyRaillO alarms

MyRaillO alarms are raised whenever there is an issue and ceased when the issue is gone. Alarms
have three severity levels:

“A”: A Critical alarm indicating that certain MyRaillO services may be inoperative all together.

“B”: ANon-critical alarm indicating that certain MyRaillO services maybe degraded in its
operations.

“C”: Anotice alarm indicating that certain MyRaillO services may be limited in their
functionality, but in no way impacting the operations.

An alarm (even an A-severity one) does not necessarily mean that the functionality is compromised

(the operational state provides the truth of the operations), but it means that something is

abnormal which may later lead to more serious issues. An alarm carries the following base

information:

“Alarm instance Id” Is the identity of this alarm occurrence.

“Alarm object Id” Is the ID of the alarm type.

“Parent Alarm Instance Id” Provides a hint of which primary alarm that may have led up to this
alarm.

“Severity”: The severity of the alarm.

“Alarm type” Provides an alarm category.

“Slogan” Provides an alarm slogan.

“Active” Indicates if the alarm is currently active or if it happened in the past.
“Alarm source” Provides the MyRaillO object source for the alarm.

“Raise time” Provides the time when the alarm was raised.

“Raise reason” Provides a reason for the alarm.

“Cease time” Provides the time when the alarm ceased.

“Cease reason” Provides a reason for why the alarm was ceased.

Additionally, some calculated data is provided with the alarm:

“Duration” The duration of the alarm.

“Occurrences” Number of occurrences of this alarm object.
“Previous occurrence” When was this alarm object previously raised?
“Intensity” Intensity of this alarm object
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Alarm view

Slogan: Light-group link has not received a valid configuration Parent Alarm Instance Id: -

Severity: A

Active: False

Duration [H:M:S]: 00:00:21 Duration [S.pS]:  21.80152201652527

Occurances: 1 Prev. occurance: - Intencity [/h]:

Meta data: Raise Info: Cease Info

| Alarm type: CONFIGURATION STATUS Time [UTC]: UTC: 2024-07-09 17:57:55.683276 Time [UTC]: UTC: 2024-07-09 17:58:17.484798

Alarm object Id: 24 Time [Epoch]: 1720540675.683276 Time [Epoch]: 1720540697.484798

Alarm instance Id: 7 Reason: Light-group link has not been configured, = Reason: Light-group link is now successfully confic
Alarm source: LgLink-GILL-MyUserGuideLgLink! —

4

Whenever a MyRaillO object is administratively “DISABLED?”, all alarms related to that object will be
ceased.

All alarms are stored until the MyRaillO server is restarted [TODO: Persistent store], there are two
stores, one for active alarms, and one for the alarm history. To see the alarm list go to
“View”->"Alarms”. In the alarm list view, you can select if you want to look at the active alarms or
the history. You may also search and filter alarms by providing an RegExp into one of the filter
boxes. By Left-clicking on an alarm you will open the detail view of that alarm.

Adarm list
Wstorys St Saveity filter: Source filter: * Free search filler: *

Esport salaction Export i

If there are any Active MyRaillO alarms an Alarm bell Icon will be lit up in the upper right corner of
the managed object tree window: A red bell indicates existence of A severity alarms, An amber bell
indicates the existence of B severity alarms, and a Yellow bell indicates the existence of C severity
alarms. A Grey bell indicates that there are no active alarms. The same color coding applies to the
active alarm list.

Under “Inventory”->"Alarm inventory” you can see what alarm objects that have been registered,
i.e., allthe possible type of alarms that can be raised by the system.
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Understanding and working with MyRaillO performance metrics

Satellites and Satelite links provide some performance metrics that are shown in their respective
configuration dialog:

e “RX-CRC errors” Number of received CRC errors (seen from the Satelite link termination)

o “TX-CRC errors” Number of transmit CRC errors (seen from the Satellite link termination)

e “Remote CRC errors" Number of receive CRC errors (seen from the satellites, based on their
link portion of data)

e “Watchdog errors” Number of Satellite watchdog timeouts.

e “RX-Symbol errors” Satelite symbol errors (Seen from the Satellite link termination)

More metrics are available through the MyRaillO decoder CLI.

Understanding and working with MyRaillO inventories

MyRaillO provides some inventory views of which the alarm inventory view already was discussed
in the alarm section.

Inventories are found under the “Inventory” menu.

Decoder Inventory

The Decoder inventory provides an inventory of all decoders with the status of them.

e “SysName” Provides the system name.

e “UsrName” Provides the user name.

e “Desc.” Provides the description.

e “OpState (Server/Client)” Provides the operational stat seen from the server and the client.
e “FWVersion” Firmware version.

e “HW Version” Hardware version.

e ”MAC Address” MAC Address.

e “MQTT Broker” MQTT Broker.

e “MQTT Client” MQTT Client (Same as Decoder URI).
e “Uplime” Time since last reboot.

e “WIFiSSID” SSID of connected WiFi.

o “WIFiRSSI” WiFi Signal strength.

o “LoglLevel” Current log level.

e “MemFree INT/EXT” Free memory (Internal/External).
e “CPUUsage” CPU load [NOT IMPLEMENTED].
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e “CoreDump” Latest core-dump (If left-clicked - the core dump will show).
e “DecoderUl” The decoder web portal (If left-clicked — the web portal will pop-up).

Becodar invartory

Light groups inventory

The Light groups inventory shows all the Light groups and their respective status.

e “SysName” Provides the system name.

e “UsrName” Provides the user name.

e “Desc.” Provides the description.

o “Type” Type of Light group

e “Subtype” Sub-type of Light group

e “LinkAddr” The Light group link address

e “OpState” Provides the operational status.

e “Showing” Indicates currently shown aspect.

e “UpTime” Uptime since it last came “AVAIL”

e “Topology” Shows the topology of the Light group, i.e., all its parents

Lot arsaums Inventory

Sensor inventory

The Sensor inventory shows all the Light sensors and their respective status.
e “SysName” Provides the system name.

e “UsrName” Provides the user name.

e “Desc.” Provides the description.
e “Type” Type of Sensor
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e “Port” The Sensor port

e “OpState” Provides the operational status.

e “Sensing” Indicates what it currently senses.

e “Uplime” Uptime since it last came “AVAIL”

e “Topology” Shows the topology of the Sensor, i.e., allits parents

Sensors inventory

Actuator inventory

The Actuator inventory shows all the Light sensors and their respective status.

e “SysName” Provides the system name.

e “UsrName” Provides the user name.

e “Desc.” Provides the description.

o “Type” Type of Actuator

e “Port” The Actuator port

e “OpState” Provides the operational status.

e “Position” Indicates what the current actuator position is.

e “Uplime” Uptime since it last came “AVAIL”

e “Topology” Shows the topology of the Actuator, i.e., all its parents

Actuators inventery
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Understanding MyRaillO restarts, escalations, and fail-safe

MyRaillO has several means to monitor its processes and poll loops.

Watchdogs make sure that processes and loops do not get stuck, and if a watchdog is triggered the
corresponding module is informed and gets a chance to fix the issue, if it cannot-, or the same
watchdog gets triggered multiple times an escalation ladder will eventually cause a Decoder
restart. The Decoder CLI provides statistics about the various watchdogs.

All communication channels such as point to point MQTT associations and RPC communication
channels have periodic keep-alive/ping supervision. In general, a decoder restart will happen after
three consecutive keep-alive/ping messages have been loosed. The Decoder CLI provides statistics
for the MQTT- and RPC supervision.

MyRaillO decoder restarts which are not fatal (machine errors) are delayed for 5 seconds in an
attempt to flush all logs to the remote RSyslog server. The backtrace (core dump) is stored in flash
so that it can later be fetched for postmortem analyses.

Whenever a decoder restart is ordered there is an attempt to set all the Managed object operational
state to “FAIL”. This will cause all the objects to take proper fail-safe actions.

When a fatal machine error occurs, the decoder will reboot immediately. This means that there is
no time to order any fail-safe actions. However, the proprietary Satelite link protocol will make sure
that all satellites go into failsafe when the link goes down. This is unfortunately not the case with
the Light groups as the WS2811/WS2812 Light group link does not have such a feature. This means
that the Light groups will remain in the state they were in before the restart, fail-safing of those will
anyway happen early in the reboot phase.

There is an option to request that all decoders are fail-safed whenever one Managed object
(wherever it resides) becomes “UNAVAIL”. This option can be used if the railway plan cannot be
segmented in a way that safe operations can be guaranteed if one object (including its
subordinates) fails. This option is found under the topDecoder configuration dialog. [NOT YET
IMPLEMENTED]

There is also a “Track failsafe” option, if enabled the track power will be shutoff whenever a
managed object becomes “UAVAIL”.
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MyRaillO troubleshooting
To trouble-shoot MyRaillO there are a few tools that come in handy.

Syslog

We have already described how to configure Syslog to stream and aggregate all log’s on to the
server and to file. Each syslog entry has a timestamp (UTC), a log severity, a module name, a line
number, followed by the actual log text.

Note that logs are buffered and may be dropped if an overload situation happens.

The log-level can be set by selecting “Debug”->"Set Log properties”, pay attention to that verbose
log levels causes high load on the system. You may want to use the decoder CLI to selectively raise
the log level for certain modules.

Live logging can be shown by selecting “Debug”->"Open Log window”

Log settings Capy to clipboard Clear display Auto-scroll Close

Core dumps

If you are experiencing decoder reboots you may want to look at the Decoder’s core-dump. You can
access the latest core-dump by opening the Decoder inventory (“Inventory”->"Show Decoders
inventory”) and click on “Coredump” for the Decoder you want to troubleshoot.

Copy to clipboard Close

Copy the core dump and paste it in to an IDE with symbol information for the Firmware version that
is running.
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CLI

The MyRaillO Decoder CLI provides a lot of tolls that can help when troubleshooting.

Other tools

Wireshark can be helpful to capture the RPC communication between JMRI and MyRaillO.

MQTT Explorer can be helpful to capture the communication between the MyRaillO server and its
decoders.

MyRaillO decoder upgrade

The MyRaillO decoders can be upgraded over the air. To do so, open the decoder Web portal by left-
clicking “Launch GUI” in the Decoder’s configuration dialog.

The Decoder Web portal will now pop-up, left-click on “Update”, next left-click on “Choose File”
and provide the new .bin firmware file, and finally left klick on “Update”
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System requirements, dependencies, and compatibility
MyRaillO Server:

e Windows 10 or later
e Python3

MyRaillO Decoder:

e Esspresif ESP32 WROVER (I)E, 4MB PSRAM, 4MB FLASH

Train controller:
e JMRI 4.24 (Upliftis planned)

Installation

TBD

References

TBD
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